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Revision

Date

Description

K.0

16 February 2024

QuantStudio™ Design and Analysis v2.8 was added.

The information about curve quality and result quality was corrected (“View or edit QC alerts settings” on
page 49). Curve quality is inactive by default. Result quality is active by default.

J.0

5 July 2023

The document was updated for QuantStudio™ Design and Analysis v2.7.

The list of compatible instruments was updated.

The list of compatible data files was updated.

Information was added about pre-run files for the OpenArray™ Plate format (“Overview of pre-run files for the
OpenArray™ Plate format” on page 9).

Instructions were added to adjust the view during the plate setup (“Edit the view” on page 18).
The instructions to edit the plate setup were updated to include the OpenArray™ Plate.
The instructions to manage the target dyes were updated to include adding a dye from the dye library.

The instructions to edit the plate information were updated to indicate that the experiment name can be
edited.

The instructions to set up a standard curve were updated to use a starting quantity of greater than 0.

The option to select by subarray for the OpenArray™ Plate format was added to the instructions to review
and analyze the data.

The instructions to review and edit the baseline and threshold values were updated to indicate that these
values can be updated only if the baseline threshold algorithm setting is used.

The instructions to edit the QC alerts in the primary analysis settings were updated to indicate that a rule that
is set up for a sample type takes precedence over a rule that is set up for all samples.

The instructions to view the plots in the Quality Check tab were updated to include the option to show or
hide the background grid.

The instructions to edit the advanced primary analysis settings were updated to include an algorithm to
reduce dye signal cross-talk.

The advanced primary analysis settings for the AR, were updated for QuantStudio™ Design and Analysis
v2.7 and later. Any curves with the AR, below the threshold are set to non-amplified. This is regardless of
whether there is a Cq value.

The instructions to edit the melt analysis settings were updated to include a melt peak parity factor.
Descriptions of the possible curve quality flags were added.

The instructions to generate a report were updated to remove the selection of the paper size. This is set in
the system preferences.

The information that is included in a report was updated.

The instructions to generate a report were updated to allow selection by subarray for the OpenArray™ Plate
format.

Instructions were added to view and adjust the images of the OpenArray™ Plate format.

The information about the analysis modules was updated to include a primary analysis module.

The instructions to manage the preferences were updated to include adding custom dyes to a dye library.
A change in passive reference was added as a QC acceptance criteria.

The instructions to select an analysis module were updated to indicate that the genotyping analysis module
is automatically applied to data files from OpenArray™ Plate genotyping runs.
Instructions were added to use different calibrations in order to analyze a file.

The instructions to edit the export settings were updated, including updating the text for the plate
information fields and the column headers.

H.0

14 March 2022

v2.6.2

The list of instruments was updated to include the QuantStudio™ 1 Plus Real-Time PCR System (available in
China).
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About the software

QuantStudio™ Design and Analysis v2 is used to set up instrument runs on and analyze data generated
with QuantStudio™ real-time PCR systems (see “Compatible instruments” on page 8).

Compatible instruments

Use the software to create plate files to run on the following instruments:

QuantStudio™ 7 Pro Real-Time PCR System

QuantStudio™ 6 Pro Real-Time PCR System

QuantStudio™ 12K Flex Real-Time PCR System (except the OpenArray™ Plate format)
QuantStudio™ 7 Flex Real-Time PCR System

QuantStudio™ 6 Flex Real-Time PCR System

QuantStudio™ 5 Real-Time PCR System

QuantStudio™ 3 Real-Time PCR System

QuantStudio™ 1 Real-Time PCR System

QuantStudio™ 1 Plus Real-Time PCR System (available in China)

Pre-run files for the OpenArray™ Plate cannot be created in the QuantStudio™ Design and Analysis v2.
For more information, see “Overview of pre-run files for the OpenArray™ Plate format” on page 9.

Compatible data files

Compatible data files

The software is compatible with data files from the following real-time PCR instruments, if the plate file
for the run was created with QuantStudio™ Design and Analysis v2:

QuantStudio™ 7 Pro Real-Time PCR System (including TagMan™ Array Card format)
QuantStudio™ 6 Pro Real-Time PCR System

QuantStudio™ 12K Flex Real-Time PCR System (including TagMan™ Array Card format, but not
including the OpenArray™ Plate format)

QuantStudio™ 7 Flex Real-Time PCR System (including TagMan™ Array Card format)
QuantStudio™ 6 Flex Real-Time PCR System

QuantStudio™ 5 Real-Time PCR System

QuantStudio™ 3 Real-Time PCR System

QuantStudio™ Design and Analysis v2 User Guide



Chapter 1 About the software [0
Compatible data files

* QuantStudio™ 1 Real-Time PCR System
* QuantStudio™ 1 Plus Real-Time PCR System (if the plate file for the instrument run is created using
QuantStudio™ Design and Analysis v2, available in China)

Pre-run files for the OpenArray™ Plate format cannot be created with the QuantStudio™ Design and
Analysis v2.

Data files for the OpenArray™ Plate are in the legacy file format. For information about a workflow for the
OpenArray™ Plate, see “Overview of pre-run files for the OpenArray™ Plate format” on page 9.

Compatible data files (legacy file format)

Data files for the following instruments are a legacy file format that can be opened and analyzed in the
software, but can only be saved as the updated file format:

* QuantStudio™ 7 Flex Real-Time PCR System (including the TagMan™ Array Card format)
¢ QuantStudio™ 6 Flex Real-Time PCR System

* QuantStudio™ 12K Flex Real-Time PCR System (including the TagMan™ Array Card and the
OpenArray™ Plate format)

¢ QuantStudio™ 5 Real-Time PCR System
* QuantStudio™ 3 Real-Time PCR System
* QuantStudio™ 1 Real-Time PCR System

* QuantStudio™ 1 Plus Real-Time PCR System (if the plate file for the instrument run was not created
using QuantStudio™ Design and Analysis Software v2, available in China)

* StepOnePlus™ Real-Time PCR System
* ViiA™ 7 Real-Time PCR System

® 7500/7500 Fast Real-Time PCR System
® 7900HT Real-Time PCR System

Note: To convert a legacy data file into the updated file format, open the data file, then click
Actions » Save As.

Overview of pre-run files for the OpenArray™ Plate format
Pre-run files for the OpenArray™ Plate format cannot be created with the QuantStudio™ Design and
Analysis v2.

A data file from the OpenArray™ Plate format can be opened in the QuantStudio™ Design and Analysis
v2. The plate setup can be saved as a CSV file. This file can be used as an OA.csv file format in the
QuantStudio™ 12K Flex OpenArray™ AccuFill™ System. This file can also be used in the QuantStudio™
Design and Analysis v2 to edit a plate setup.

For information about saving the plate setup as a CSV file, see “Export a plate setup file” on page 35.

QuantStudio™ Design and Analysis v2 User Guide 9



Workflow

Set up a plate file

I

Set up a plate file (page 11)

Select a system template or existing plate file to set up a new plate file
(page 11)

Confirm or edit run method (page 13)

Confirm or edit plate setup (page 18)

Review the plate file and save (page 35)

Review and analyze data

Review and analyze data (page 37)

Review results in the Amplification Plot (page 38)

Identify and omit outliers from analysis (page 44)

Export results (page 55)

10 QuantStudio™ Design and Analysis v2 User Guide



Set up a plate file

Select a system template or existing plate file to set up a
new plate file

Plate files cannot be created for the OpenArray™ Plate format with the QuantStudio™ Design and
Analysis v2. For information about a workflow for the OpenArray™ Plate format, see “Overview of
pre-run files for the OpenArray™ Plate format” on page 9.

A limited number of items in the data files for the OpenArray™ Plate format can be edited. It is noted in
each section of this format can be edited.

A new plate file must be created from a system template or a previously created plate file. For more
information about system templates and plate files, see “Overview of system templates and plate files”
on page 64.

IMPORTANT! You must select a system template or a plate file that corresponds to your instrument,
block, and run mode. These properties are not editable once the plate file has been created.

1. In the home screen, click s Set Up Plate.
The Plate Gallery opens to the System Templates tab.

2. In the left pane, select the appropriate options to filter the system template and plate file lists.
¢ Instrument
¢ Block
* Run Mode
* Analysis

Note: Thermal protocol, plate setup, and post-run analysis options are independent of
analysis module selection. Analysis module selection can be changed at any point during
plate file set or post-run analysis (see “Select an analysis module” on page 68).

QuantStudio™ Design and Analysis v2 User Guide 11
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Chapter 3 Set up a plate file
Select a system template or existing plate file to set up a new plate file

3. Navigate to appropriate Plate Gallery tab.

Tab Description

System Contains system templates, non-editable plate files that are included with the

Templates software.
Click a system template to automatically generate a new plate file that can be
edited, then saved.

My Plate Files | Contains plate files that were previously saved to My Plate Files.
Click an existing plate file to automatically generate a new plate file that can be
edited, then saved.

Recents Contains plate files that were recently opened. Recently opened plate files from
System Templates and My Plate Files do not populate this tab.
Click a plate file to open it. The plate file can be edited, then saved, or saved as a
new plate file.

Note: Click Q to search for a plate file based on a tag (see “Edit plate file or data file information”

on page 34).

QuantStudio™ Design and Analysis v2 User Guide




Chapter 3 Set up a plate file 5
Confirm or edit run method

Confirm or edit run method

Run method elements

Edit run method elements in the Run Method tab.

1 /1\ |
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40x

®
@ Stage @ Add/remove step
(2) Step within a stage Number of PCR cycles
@ Temperature ramp rate of a step @ PCR stage pause cycle
(@) Temperature of a step Data collection on
@ Time length of a step @ Data collection off

(®) Add/remove stage

Apply the recommended run method for your master mix

Override the current run method with the run method that we recommend for use with your master
mix, instrument, block, and run mode. The recommended run method can differ depending on the
application being used. We recommend that you confirm the run method in the master mix user guide.

1. On the right side of the Run Method tab, click --- (Actions) » Select Master Mix.

( Actions V]

2. Search for your master mix by name or catalog number, or select a master mix from the list.
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P2 Chapter 3 Set up a plate file
Confirm or edit run method

3. (Optional) To add the master mix to the reagents table in the Plate Setup tab, select Append
selected master mix to reagent table.
The master mix is added to the Reagent Table in the Plate Setup tab (see “Edit reagent
information” on page 32).

4. Click Apply.

The run method is updated to the recommended run method for the selected master mix.

Edit temperature ramp rate, temperature, and time length for a step

1. In the Run Method tab, in the step of interest, click the temperature ramp rate, temperature, or
time length element.

For more information about elements in the run method, see “Run method elements” on page 13.

2. Enter the value, then click outside the element to stop editing.

Each filter set has a minimum exposure time. A warning is displayed if the time is shorter than the
minimum exposure time.

Add or remove a step

1. In the Run Method tab, hover over the stage for which you want to edit steps to view the [+] and
buttons.

* The buttons at the top of the stage control adding and removing stages.
* The buttons at the bottom of the stage control adding and removing steps.

* For more information about elements in the run method, see “Run method elements” on
page 13.

2. At the insert location, click [+] at the bottom of the stage.

3. (Optional) Edit the temperature ramp rate, temperature, or time length of the new step (see “Edit
temperature ramp rate, temperature, and time length for a step” on page 14).

4. To remove a step, click [~ at the bottom of the step.

Add or remove a stage

1. In the Run Method tab, hover over where you want to insert the stage to view the [+| and
buttons.

* The buttons at the top of the stage control adding and removing stages.
* The buttons at the bottom of the stage control adding and removing steps.

* For more information about elements in the run method, see “Run method elements” on
page 13.

2. At the insert location, click [+] at the top of the stages.

14 QuantStudio™ Design and Analysis v2 User Guide



Chapter 3 Set up a plate file S
Confirm or edit run method

3. Select the type of stage from the list.

Option Description

Hold ¢ Multiple hold stages can be added.

Pre-Read ¢ Only one pre-read stage can be added.
* A pre-read stage can only be added to the beginning of the run method.

Post-Read | * Only one post-read stage can be added.
* A post-read stage can only be added after the final PCR stage of the run method.

Infinite ¢ Only one infinite hold stage can be added.

* An infinite hold stage can only be added to the end of the run method.

PCR * Multiple PCR stages can be added.

Melt Curve | ¢ Multiple melt curve stages can be added.

4. (Optional) Edit the temperature ramp rate, temperature, or time length for steps of the new stage

(see “Edit temperature ramp rate, temperature, and time length for a step” on page 14).

5. To remove a stage, hover of the stage of interest, then click (-] at the top of the stage.

Add, edit, or remove a pause cycle in a PCR stage

1.

In a legacy template, in the Run Method tab, click [l at the bottom of the PCR stage.
For more information about elements in the run method, see “Run method elements” on page 13.

To add a pause to the PCR stage, select Pause Cycle.

To edit a pause, enter a pause temperature between 4°C and 99.9°C.

CAUTION! PHYSICAL INJURY HAZARD. During instrument operation, the plate temperature
can reach 100°C. To access the plate during a run pause, enter room temperature as the pause
temperature and allow the plate to cool to room temperature before handling.

Enter the appropriate cycle after which the pause will occur.
Click Save.

(Optional) To remove a pause, click [, then deselect Pause Cycle.

Add, edit, or remove a pause cycle in a PCR step

1.

In a QuantStudio™ 6 Pro or 7 Pro Real-Time PCR System template, in the Run Method tab, click
£+ (Advanced Setting) in a step.

Note: Any changes apply only to the step in which you clicked.

QuantStudio™ Design and Analysis v2 User Guide 15



2 Chapter 3 Set up a plate file
Confirm or edit run method

2. In the Pause Setting tab, select Pause Cycle.

Note: Pause Setting is not available for the melt curve dissociation step.

3. In the Pause Temperature field, enter a pause temperature between 4°C and 99.9°C.

CAUTION! PHYSICAL INJURY HAZARD. During instrument operation, the plate temperature
can reach 100°C. To access the plate during a run pause, enter room temperature as the pause
temperature and allow the plate to cool to room temperature before handling.

4. Inthe Pause After Cycle field, enter the appropriate cycle after which the pause will occur.

5. Click Save.
A PCR step with a pause cycle applied to it is denoted with 11 in the top-left corner of the step.

6. (Optional) To remove a pause cycle, deselect Pause Cycle.

Edit the ramp increment for the melt curve dissociation step

1. In the Run Method tab, in the Melt stage, click the name of the ramp increment method, then
select one of the following options:

Option Description
Continuous (default) Continuously increases the temperature by the ramp increment
(°C/sec).
Step and Hold Increases the temperature by the ramp increment (°C), then holds at
that temperature for the specified time.
No. of Data Points per Increases the temperature by the ramp increment (°C) and collects the
Degree specified number of data points per degree increased.

2. Edit the temperature ramp increment.
a. Click the ramp increment element in the Dissociation step.

b. Enter a value or use the up/down arrows (default is 0.15°C/s).

3. (Step and Hold only) Edit the hold time after each temperature increase.
a. Click the time field next to Step and Hold.

b. Enter a value or use the up/down arrows (default is 5 seconds).

4. (No. of Data Points per Degree only) Edit the number of data points to be collected with each
degree increase.

a. Click the number of data points element in the Dissociation step.

b. Enter a value or use the up/down arrows (default is 10 data points).

16 QuantStudio™ Design and Analysis v2 User Guide
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Chapter 3 Set up a plate file ~ FFai®
Confirm or edit run method

edit, or disable Auto Delta

Auto Delta enables the incremental increase or decrease of the temperature or hold time for a step in a
PCR stage.

Not all instruments support Auto Delta. For specific information about Auto Delta, see the instrument
documentation.

1.

7.

Enable,

In the Run Method tab, click £+ (Advanced Setting) in a step.

Note: Any changes apply only to the step in which you clicked.

In the Auto Delta Settings tab, select Enable Auto delta.

In the Temperature Delta field, enter the numerical difference in the temperature. The software
indicates the appropriate range.

In the Time Delta field, enter the numerical difference in the time. The software indicates the
appropriate range.

In the Starting Cycle field, enter the first cycle to which you want Auto Delta settings to apply.

Click Save.
A PCR step with an Auto Delta setting applied to it is denoted with A.

(Optional) To remove Auto Delta, deselect Enable Auto delta.

edit, or disable VeriFlex™ zones

VeriFlex™ Zones enable independent temperature zones <5°C of adjacent zones.

—

w

b

o

The number of VeriFlex™ zones depends on the instrument. For specific information about
VeriFlex™ zones, see the instrument documentation.

VeriFlex™ zones are only available for 96-well blocks.

. In the Run Method tab, click £ (Advanced Setting) in a step.

Note: Any changes apply only to the step in which you clicked.

. In the VeriFlex™ Zones tab, select Enable VeriFlex™.

In the Adjusted Temperature (°C) fields, enter the adjusted temperature.

Click Save.
A step with VeriFlex™ Zones applied to it is denoted with \/.

(Optional) To remove VeriFlex™ Zones, deselect Enable VeriFlex™.

QuantStudio™ Design and Analysis v2 User Guide 17



5¥ Chapter 3 Set up a plate file
Confirm or edit plate setup

Confirm or edit filter settings

The need to edit optical filter settings is rare, and it is for advanced or custom uses only. For more
information about instrument supported dyes and their calibration and optical filter selection, see the
instrument documentation.

Use the optical filters settings to select a filter set to match the profile of a custom dye.

1. On the right side of the Run Method tab, click --- (Actions) » Filter Settings.

‘ Actions V’

The excitation (x) and emission (m) wavelengths that correspond to each filter are shown on the
screen.

2. Select the check boxes to enable or disable filters.

IMPORTANT! If you select the wrong filters, you cannot correct the selection and retrieve data
after a run has been completed.

3. Click Save.

Confirm or edit plate setup

Note: The table view is not available for the OpenArray™ Plate format. The table view is noted by the
= icon.

Edit the view

Edit the grid view
The grid view is displayed in the Plate Setup tab. It matches the plate layout of a physical plate.
This is not available for the OpenArray™ Plate format.

In the plate layout pane, click :i: (Grid View).
1. In the top-right corner of the plate layout pane, click @ (Zoom In) and @ (Zoom Out).
2. Click the percentage value, then use the slider to select a scaling based on a numerical value.

3. Click "=, (Reset) to reset the zoom to fit the screen width.
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Chapter 3 Set up a plate file ~ FPaH
Confirm or edit plate setup

4. Click & (Settings), the select the following options from the dialog box.

Section Option

Show ¢ Sample Color

* Target Color or SNP Assay Color

Select one, none, or all of the options.

Tab/Auto Fill ¢ Horizontal
Direction e Vertical

Select one option.

This option selects the direction of the next well that is selected when Tab or Enter
is pressed.

Dock Table ¢ To Right

* To Bottom

Select one option.

This option selects whether the tables are displayed on the right of the screen or on
the bottom of the screen.

The tables include the Samples table, the Targets table, and the SNP Assays table.

5. If any of the wells display an invalid setup, hover over the warning icon to view the reason.

QuantStudio™ Design and Analysis v2 User Guide 19
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Chapter 3 Set up a plate file
Confirm or edit plate setup

Edit the table view

The table view is displayed in the Plate Setup tab.

This is not available for the OpenArray™ Plate format.

In the plate layout pane, click := (Table View).

1. In the top-right corner, click View.

2. Select or deselect the checkbox associated with each item to display in the table view.

Table

Options

Target

Well checkbox

Sample Name checkbox
Sample Type checkbox
Target Name checkbox
Target Reporter checkbox
Target Quencher checkbox
Task checkbox

Quantity checkbox

SNP

Well checkbox

Sample Name checkbox
Sample Type checkbox
Assay Name checkbox
Allele 1 Name

Allele 1 Reporter checkbox
Allele 1 Quencher checkbox
Allele 2 Name

Allele 2 Reporter checkbox
Allele 2 Quencher checkbox

Task checkbox

3. Click & (Settings), the select the following options from the Dock Table dialog box.

¢ To Right radio button
¢ To Bottom radio button

This setting selects whether the tables are displayed on the right of the screen or on the bottom of

the screen.

The tables include the Samples table, the Targets table, and the SNP Assays table.
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Select plate wells or ports

® Select plate wells or ports in the 2:2 (Grid View).

Note: Selecting ports is only available for TagMan™ Array Card plate setup.

To Action

Select a single well Click a well in the plate
Select multiple wells Click-drag in the plate
Select contiguous wells Shift-click wells in the plate

Select non-contiguous wells | PC: Ctrl-click wells in the plate
Mac: Cmd-click wells in the plate

Select a column of wells Click a column header

Select all wells Click the top-left corner of the plate grid

Select a block of wells Click a well to define a corner, then shift-click another well on the
opposite corner

Select a single port!'] Click a cell in the Port column

Select multiple ports!!] Click-drag in the Port column

Select all ports!'! Click the Port column header

1 For TagMan™ Array Cards only.

* Select plate wells in the := (Table View).
This view is not available for the OpenArray™ Plate format.

To Action

Select a single well Click a row in the table

Select contiguous wells Shift-click rows in the table
Select non-contiguous wells PC: Citrl-click rows in the table

Mac: Cmd-click rows in the table

Deselect a single well PC: Ctrl-click the selected row
Mac: Cmd-click the selected row

Add samples and assign to plate wells

Import a plate setup file (samples)

Import a plate setup file that was previously exported from the software (see “Export a plate setup file”
on page 35), or a user-created plate setup file. The following file types can be imported as a plate
setup file:

* TXT—text format
® (CSV—comma-separated values format
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A sample layout can be imported for the OpenArray™ Plate format. Targets or SNP assays cannot be
imported for an OpenArray™ Plate format.

For all of the other formats, the plate setup file can include both samples and targets or SNP assays.

1. In the Plate Setup tab, in the plate layout pane, click one of the following options.

Format Procedure
96-well, 0.2-mL plate Click -+ (Actions) » Import Plate Setup.
96-well, 0.1-mL plate
384-well plate
TagMan™ Array Card
OpenArray™ Plate Click «+- (Actions) » Import Sample Layout.

2. Navigate to, then select the file.

3. Click OK to confirm that the plate setup is overwritten.

Copy samples from the plate layout
Copy is available for all formats.

For the TagMan™ Array Card plate setup and the OpenArray™ Plate format, this feature copies the
information to the clipboard. It can be copied into another program for reference.

Paste is not available for TagMan™ Array Card plate setup or the OpenArray™ Plate format.

1. Navigate to the Plate Setup tab.
2. In the Samples table, click --- (Actions) » Copy all samples.
The information is available in the clipboard. It can be pasted into another program for reference.

Paste samples into the plate layout

You can copy samples from an Excel™ spreadsheet, then paste them into the Plate Setup tab.

Note: Paste is not available for TagMan™ Array Card plate setup or the OpenArray™ Plate format.

1. Create an Excel™ spreadsheet with the plate setup information.
2. In the spreadsheet, select, then copy the cells of interest.

3. Navigate to the Plate Setup tab.

4. |n the Samples table, click --- (Actions) » Paste samples.

The samples are copied to the Samples table. They must be assigned to the plate layout (see
“Manually add or assign a sample to a well or port” on page 23.
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Manually add samples to the Samples table

Each sample name in the Samples table must be unique. Do not add multiple entries for technical
replicates.

Adding a single sample is not available for the OpenArray™ Plate format.

1. In the Plate Setup tab, select an option in the upper right corner of the Samples table.

Option Description

Add a single Click 4 (Add).
sample

Copy/paste

) a. Copy the sample information from one of the following sources:
multiple samples

* Previously created plate file or data file—Click --- (Actions) » Copy all
Samples in the upper-right corner of Samples table.

* Excel file—Select, then copy data, including column headers.[1]
* Plate setup file—Select, then copy data, including column headers. !
b. Click --- (Actions) » Paste Samples.

[l Column headers must match the column headers in the Samples table.

Note:
. Click :-- (Actions) » Export Samples to export samples.

. Click --- (Actions) » Import Samples to import samples.

2. (Optional) Edit the sample color and sample type (see “Edit sample name, color, and type” on
page 24).

Note: The software automatically assigns a task to the target or SNP assay based on the sample
type in a well (see “(Optional) Edit the task assigned to a target or SNP assay in one or more wells”
on page 30).

3. To remove a sample from the table, click X (Remove) in the last column.

Manually add or assign a sample to a well or port
Sample assignment by port is available only for TagMan™ Array Card plate setup.
This is not available for the OpenArray™ Plate format.
1. In the Plate Setup tab, in the plate layout pane, perform one of the following actions.

* Select one or more wells in the 2i2 (Grid View) or in the := (Table View).

® Select one or more ports in the 222 (Grid View).
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2. Assign a sample to the selected well or port.

Note: The user can only assign up to eight samples by port in the 22 (Grid View) for TagMan™

Array Card plate setup.

Option

Description

222 (Grid View)

Sample not defined

Enter the sample name in the text field.

Sample previously defined

e Start typing the sample name, then select the sample name from the
autocomplete list.

* Select the checkbox of the sample in the Samples table.

= (Table View)

Sample previously defined

Select the checkbox of the sample in the Samples table.

3. (Optional) Edit the sample color and sample type (see “Edit sample name, color, and type” on

page 24).

Note: The software automatically assigns a task to the target or SNP assay based on the sample
type in a well (see “(Optional) Edit the task assigned to a target or SNP assay in one or more wells”

on page 30).

Edit sample name, color, and type

The software automatically assigns a task to the target or SNP assay based on the sample type in a
well (see “(Optional) Edit the task assigned to a target or SNP assay in one or more wells” on page 30).

The sample name, color, and type can be edited for the OpenArray™ Plate format.

1. In the Plate Setup tab, in the Samples table, click the sample name in the Name column.

2. Enter a new name, then press Enter.

3. Click the sample color in the Color column, then select a color from the color picker.

4. Select a sample type from the Type column dropdown list.

* Unknown (default)
e Standard

Note: A standard sample requires that you enter a value in the Quantity column of the
Samples table. The software uses this value to populate the Quantity field for standard target
tasks in the Targets table.

* Negative Control
* Positive Control

¢ Positive 1/1—A sample that is homozygous for allele 1.

¢ Positive 2/2—A sample that is homozygous for allele 2.

¢ Positive 1/2—A sample that is heterozygous for allele 1 and 2.
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IMPORTANT! Editing the sample type after a run can affect the validity of the plate setup.

Add a custom attribute to samples

Custom attributes can be added for the OpenArray™ Plate format.

1. In the Plate Setup tab, in the Samples table, click --- (Actions) » Add Custom Attribute.

2. In the Add Custom Attribute window, enter the custom attribute name, then click Done.
A column for the custom attribute is added to Samples table, and a new tab for the custom
attribute is created.

3. Select an option to define the choices for the custom attribute:

Option Description

Define in the Samples table |In the Samples table, define the custom attribute in the appropriate
field in the custom attribute column.

Define in the custom a. In the custom attribute tab, click 4 (Add).
attribute tab L ' . .
b. In the table, click in the field to edit the custom attribute name.

The custom attribute options are added to the following locations:
* Samples table, in the dropdown list in the custom attribute column

* Table in the custom attribute tab

4. Inthe Samples table, for each sample, select the custom attribute from the dropdown list.

5. (Optional) Edit the custom attribute name or color.
a. Select the custom attribute tab.

b. In the table, click a field to edit.
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Import plate setup from TagMan™ files

Import assay information using your TagMan™ assay order details. The plate setup information
extracted from TagMan™ files is the same as the information in the Assay Information File (AIF), and

does not include sample information.

Importing the TagMan™ files is not available for the OpenArray™ Plate format.

Note: Using this feature requires an internet connection.

1. In the Plate Setup tab, in the plate layout pane, click --- (Actions) » Import TagMan™

assay/plates & card files.

2. Select a product from the dropdown list, then enter the required information.

Product

Required Information

TagMan™ Assays

® Sales Order Number
¢ Rack/Plate ID

Fixed TagMan™ Array Cards

* Part Number

* Lot Number

Custom Gene Expression TagMan™ Array Cards

* Sales Order Number
®* Lot Number

Custom Advanced miRNA TagMan™ Array Cards

® Sales Order Number
* Lot Number

Fixed TagMan™ Array Plates

* Part Number
e Batch Number

Custom TagMan™ Array Plates

® Sales Order Number
® Batch Number

3. Click Import Plate Setup.
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Import an Assay Information File (AIF)

An Assay Information File (AIF) is provided with every TagMan™ assay order. An AIF does not include
sample information.

Importing an AIF is not available for the OpenArray™ Plate format.

Note: TagMan™ Array Card plate setup requires AlIF import, as targets cannot be added, assigned, or
edited manually for TagMan™ Array Cards.

Prior to plate setup, download the AlF for your order at thermofisher.com/tagmanfiles.

Note: To directly import AIF information into the Plate Setup without having to first download the file,
see “Import plate setup from TagMan™ files” on page 26.

1. In the Plate Setup tab, in the plate layout pane, click --- (Actions) » Import AIF.
2. Navigate to, then select the previously downloaded AIF file.

3. Click Open.

Import a plate setup file

Import a plate setup file that was previously exported from the software (see “Export a plate setup file
on page 35), or a user-created plate setup file. The following file types can be imported as a plate
setup file:

* TXT—text format
® (CSV—comma-separated values format

This is not available for the OpenArray™ Plate format.

1. In the Plate Setup tab, in the plate layout pane, click --- (Actions) » Import Plate Setup.
2. Navigate to, then select the file.

3. Click OK to confirm that the plate setup is overwritten.

Copy targets or SNP assays from the plate layout
Copy is available for all formats.

For the TagMan™ Array Card plate setup and the OpenArray™ Plate format, this feature copies the
information to the clipboard. It can be copied into another program for reference.

Paste is not available for TagMan™ Array Card plate setup or the OpenArray™ Plate format.

1. Navigate to the Plate Setup tab.

2. In the Targets table or the SNP assays table, click one of the following items.

® ... (Actions) » Copy all targets
e ... (Actions) » Copy all SNP assays
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The information is available in the clipboard. It can be pasted into another program for reference.

Paste targets or SNP assays in the plate layout

You can copy targets or SNP assays from an Excel™ spreadsheet, then paste them into the Plate Setup
tab.

Note: Paste is not available for TagMan™ Array Card plate setup or the OpenArray™ Plate format.

1. Create an Excel™ spreadsheet with the plate setup information.
2. In the spreadsheet, select, then copy the cells of interest.

3. Navigate to the Plate Setup tab.

4. Inthe Targets table or the SNP assays table, click one of the following items.

® ... (Actions) » Paste targets
® ... (Actions) » Paste SNP assays

The targets or SNP assays are copied to the respective table. They must be added to the plate layout
(see “Manually add or assign a target or SNP assay to a well” on page 29).
Manually add targets or SNP assays to the Targets or SNP Assays table

Targets cannot be added manually for TagMan™ Array Card plate setup. To add targets for TagMan™
Array Cards, see “Import an Assay Information File (AIF)” on page 27.

Targets cannot be added manually for the OpenArray™ Plate format.

1. In the Plate Setup tab, in the plate layout pane, select Target or SNP to display the appropriate
table in the right pane.

2. Select an option in the upper right corner of the Targets or SNP Assays table.

Option Description

Add a single target or | Click 4 (Add).
SNP assay

Copy/paste multiple

targets or SNP i i )
assays * Targets or SNP Assays table from plate file or data file—Click

.-+ (Actions) » Copy all Targets/SNP Assays in the upper-right
corner of Targets or SNP Assay table.

a. Copy the information from one of the following sources:

* Excel file—Select, then copy data, including column headers.[!]
* Plate setup file—Select, then copy data, including column headers.!!
b. Click :-- (Actions) » Paste Targets/SNP Assays.

' Column headers must match the column headers in the Targets or SNP Assays table.
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Note:
. Click --- (Actions) » Export Targets/SNP Assays to export targets or SNP assays.

. Click --- (Actions) » Import Targets/SNP Assays to import targets or SNP assays.

3. Click in a cell in the table to edit the attributes for the target or SNP assay.

4. To remove a target or SNP assay, click X (Remove).

Manually add or assign a target or SNP assay to a well

Targets cannot be added or assigned manually for TagMan™ Array Card plate setup. To add or assign
targets for TagMan™ Array Cards, see “Import an Assay Information File (AIF)” on page 27.

This is not available for the OpenArray™ Plate format.

1. In the Plate Setup tab, in the plate layout pane, select one or more wells in the 232 (Grid View) or
the := (Table View).

2. Assign the target or SNP assay to the selected well.

Option Description
ii: (Grid View)
Target or SNP assay not Enter the target or SNP assay in the text field.
defined
Target or SNP assay previously | e Select the target or SNP assay from the dropdown list.
defined ¢ Select the checkbox of the target or SNP assay in the Targets

table or SNP Assays table.

= (Table View)
Target or SNP assay previously | Select the checkbox of the target or SNP assay in the Targets table
defined or SNP Assays table.

Note: In Targets table or SNP Assays table, change the default selections for the reporter and
quencher dyes and for tasks (see “(Optional) Edit the task assigned to a target or SNP assay in one

or more wells” on page 30).
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(Optional) Edit the task assigned to a target or SNP assay in one or more wells

The software automatically assigns a task to the target or SNP assay in a well based on the sample
type in that well. The automatic task assignment can be edited, if needed (except for TagMan™ Array
Card plate setup and the OpenArray™ Plate format).

1. In the Plate Setup tab, in the plate layout pane, select plate wells in the 123 (Grid View) or the
= (Table View) (see “Select plate wells or ports” on page 21).

If selecting multiple wells, only select well that have the same target or SNP assay, and the same

sample type.

2. In the Targets or SNP Assays table, confirm that the checkbox of the target or SNP assay is

selected.

3. Select a detection task from the Task column dropdown list.

The available task options depend on the sample type in the selected well (see “Edit sample name,
color, and type” on page 24).

Task

Description

Unknown (default)

The well contains an unknown sample.

Standard!!

The well contains a sample with known standard quantities.

Note: The quantity for the standard sample should be entered in the Samples table. For
each target, the value entered in Quantity column in the Targets table must be the same
for every well.

Negative Control

The well contains water or buffer instead of sampile.

Positive Control

The well contains a positive control.

Internal positive control
(PC) A

The well contains a short synthetic DNA template. The IPC is used to distinguish between
true negative results and negative results caused by PCR inhibitors, incorrect assay
setup, or reagent or instrument failure.

Blocked IPC The well contains an IPC blocking agent, which blocks amplification of the IPC.
Positive 1/1 The well contains a sample homozygous for allele 1.

Positive 2/2 The well contains a sample homozygous for allele 2.

Positive 1/2 The well contains a sample heterozygous for allele 1 and 2.

' For standard curve and relative standard curve analysis only.
[l For presence/absence analysis only.

Edit the target or SNP assay name and color

The sample name and color can be edited for the OpenArray™ Plate format.

1. In the Plate Setup tab, in the Targets table or the SNP Assays table, click the name in the Target
column or the SNP Assays column.

2. Enter a new name, then press Enter.

3. Click the sample color in the Color column, then select a color from the color picker.

30
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Manage target dyes
Managing the target dyes is not available for the OpenArray™ Plate format.

To add a custom dye from the library, ensure that the custom dye has been added (see “Manage
preferences for custom dyes” on page 72).

1. In the Plate Setup tab, in the plate layout pane, click --- (Actions) » Manage Dyes.
The Manage Dyes dialog box is displayed.

2. View system dyes in the System Dyes tab.
All of the system dyes are available to set up the plate file.

3. Add a custom dye.

Option Instructions

Addacustom | 5 Cjick the Custom Dyes tab.

dye f th
ye from the b. Select the Show custom dyes from the library, and click to import checkbox.

library.
In the Library Dye Name column click the dye to add.
The dye and the details of the dye are displayed in the table on the right.
d. Click Close.
Add a new a. Click the Custom Dyes tab.
custom dye.

b. Deselect the Show custom dyes from the library, and click to import
checkbox.

c. Click 4 (Add).
d. Edit the following fields:
* Enter a name in the Dye Name field.
* Select a color from the color picker.
¢ Select a type from the Type dropdown list.
¢ Enter a wavelength in the Wavelength field.
e. Click Close.

If a new custom dye is added when setting up a plate file, it is not applied to the system. A custom
dye must be added in the Preferences page in order to apply to the system.

4. (Optional) Click X (Remove) » OK to remove a dye from the table.

5. Click Close.
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Reagents can be edited for the OpenArray™ Plate format.

1. In the Plate Setup tab, in the Targets/SNP Assays table pane, click Reagents.

2. In the Reagents table, click 4 (Add).

Note:
. Click --- (Actions) » Export Reagents to export reagents.

. Click --- (Actions) » Import Reagents to import reagents.
. Click --- (Actions) » Scan Reagents to scan reagents.

3. Enter the following information for each reagent.

* Name * Part Number
* Type ® Lot Number
* Barcode * Expiration Date

Note: If the master mix that you enter is not compatible with the current run method, you have
the option to apply the recommended run method for your master mix, instrument, block, and run
mode.

For more information about setting up the recommended run method for your master mix, see
“Apply the recommended run method for your master mix” on page 13.

4. (Optional) Click X (Remove) in the row of a reagent to delete it from the table.
Select a passive reference

1. In the upper-left corner of the Plate Setup tab, select a passive reference from the dropdown list.

2. (Optional) Save the plate file or data file.

Set up the standard curve

A standard curve is only required for standard curve or relative standard curve analysis. See the
appropriate analysis module for more information.

Note:

. Multiple targets can be assayed using standard curve analysis, but each target requires its own
standard curve.

. You can also set up the standard curve during sample setup (see “Add samples and assign to plate
wells” on page 21).

1. In the Plate Setup tab, in the plate setup pane, click --- (Actions) » Standard Curve Setup.
The Standard Curve Wizard opens.

2. In the Standard Curve Wizard pane, enter the sample name prefix.
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3. Select the target for the standard curve.

Option Instructions
Target previously defined Select the target from the dropdown list.
Target not previously defined 1. Type the target name, then press Enter.

2. Select a reporter from the dropdown list.
3. Select a quencher from the dropdown list.

4. Adjust the parameters for the dilution series if needed.
¢ Number of points—5 recommended
* Number of replicates —3 recommended
¢ Starting Quantity —The highest or lowest standard quantity, without units.

Note: The quantity must be greater than O.

* Serial Factor

Note: The serial factor calculates quantities for all standard curve points.

— Starting quantity is the highest value—Select 1:10 to 1:2.
— Starting quantity is the lowest value—Select 2x to 10x.

5. Select an option to select the wells for the standard.

* Select Automatically.
* Select Manually, then select wells using the displayed plate layout.

6. Select to arrange the standards in Rows or Columns.

7. Click Apply Standard Curve, then click Close to return to the Plate Setup tab.
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Add biogroups and assign samples
Biogroups, or Biological Replicate Groups, are reactions that contain identical components and
volumes, but evaluate separate samples of the same biological source. Biogroups can be used in
relative quantification analysis.

1. In the Plate Setup tab, in the upper right pane, select an option to add biogroups:

Option Description
Add biogroups in the In the Samples table, enter the new biogroup name in the Biogroup
Samples table field.

The biogroup is added to the following locations:
e Samples table Biogroup dropdown list
* Biogroup table

Add biogroups in the

a. Click Biogroup.
Biogroup table

b. In the Biogroup table, click 4 (Add).

2. In the Samples table, for each sample in a biogroup, select a biogroup from the dropdown list.

3. (Optional) Edit the biogroup name or color.
a. Click Biogroup.

b. In the Biogroup table, click a field to edit.

Edit plate file or data file information

The plate file can be edited for the OpenArray™ Plate format.

—

. Click Actions » Plate Information.

2. In the Plate Information dialog box, edit the Experiment Name field.

1

(Optional) Click in the Barcode field, then perform one of the following steps.

* Scan the plate barcode with a barcode scanner.
¢ Manually enter the plate barcode.

E

(Optional) Add a tag.

(8]

. (Optional) Enter a comment in the Comment field.
6. Click Save.

Save the updated plate file or data file.
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Review the plate file and save

1.

In the Run Summary tab, review the run method selections, then edit if needed (see “Confirm or
edit run method” on page 13).

Review the plate setup, then edit if needed (see “Confirm or edit plate setup” on page 18).
(Optional) Click the barcode field, then scan the plate barcode.

(Optional) Select Add to My Plates Files.

Click Save Plate File.

Name the plate file, navigate to the folder location, then click Save.

Click Done to close File Saved dialog box.

Start the run on an instrument that is linked to Connect. For specifics on starting an instrument run,
see the instrument documentation.

(Optional) To view the run data in real time, click @ InstrumentConnect in the left sidebar, then
click Instruments.

Export a plate setup file

Export a plate setup file to use during future plate setups (see “Import a plate setup file (samples)” on
page 21).

The following files types can be exported:

TXT —text format
CSV—comma-separated values format

Samples are exported for the OpenArray™ Plate format. The targets are not exported.

Export the sample layout to use for sample integration in the QuantStudio™ 12K Flex OpenArray™
AccuFill™ System.

1.

In the Plate Setup tab, in the plate layout pane, click one of the following options.

Format Procedure
96-well, 0.2-mL plate Click «-+ (Actions) » Export Plate Setup.
96-well, 0.1-mL plate
384-well plate
TagMan™ Array Card
OpenArray™ Plate Click -+ (Actions) » Export Sample Layout.

2. Name the file, navigate to the desired folder location, select the file format, then click Save.
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Print the layout

Printing the layout saves the information in one of the following file formats:
e XLSX
e PDF
For the OpenArray™ Plate format, each cell in an XLSX file format represents a subarray.

Samples are represented for the OpenArray™ Plate format. The targets are not represented.

These files are for reference. To export in a format that can be imported, see “Export a plate setup file
on page 35.

1. In the Plate Setup tab, in the plate layout pane, click one of the following options.

Format Procedure
96-well, 0.2-mL plate Click --- (Actions) » Print Layout.
96-well, 0.1-mL plate
384-well plate

TagMan™ Array Card

OpenArray™ Plate Click -+ (Actions) » Print Sample Layout.

2. Name the file, then navigate to the desired folder location.

3. Select the file format.

* Select the XLSX radio button
* Select the PDF radio button

4. If PDF file format was selected, select the paper size.

* Select the A4 radio button
* Select the Letter radio button

5. Click Save.
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Review and analyze data

We recommend that you analyze data using the default analysis settings. If the default analysis settings
are not suitable for the data, modify the analysis settings, then reanalyze the data.

For information about general procedures to analyze data in the Quality Check tab, see Chapter 6,
“General procedures to analyze data in the Quality Check tab”.

Workflow: General procedures to review the primary
analysis results

The software automatically analyzes run data using the analysis settings that are specified during plate
file set up. The software then displays analysis results in the Quality Check tab.

To perform additional analysis, click i (AppConnect) on the left side of the screen, then select an
analysis module.

Review results in the Amplification Plot to confirm or correct
threshold and baseline settings (Review results in the Amplification Plot

(page 38))
v
Review data for outliers and (optional) omit wells (Identify and omit outliers from analysis (page 44))
v

(Optional) View the Multicomponent Plot to review the dye signal profile (Review results in the
multicomponent plot (page 44))

v
(Optional) View the Raw Data Plot to review the signal profile (Review results in the raw data plot (page 45))
v
(Optional) Review flags and QC alerts (Review QC alerts in the well table (page 47))
v

(Optional) Edit analysis settings (Edit primary analysis settings (page 48))

IMPORTANT! If you omit wells, click Analyze to reanalyze the data.
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Open a data file

To import data files to your Connect account, click f@ (DataConnect) on the left side of the screen.

1. In the home screen, click Open File.

2. Navigate to, then open a data file.
* In the data file, the analysis results are displayed in the Quality Check tab.
* The data file is added to the Data Gallery, and appears in the Recents tab.

Select by subarray

When viewing the Quality Check tab for data from the OpenArray™ Plate format, the option to view by
subarray is provided.

1. In the Quality Check tab, in the plate layout pane, toggle Select by Subarray on.
2. Click the subarray of interest.

3. Select multiple subarrays, if required.

* Use the control + click function to select multiple subarrays.
* Use the click + drag function to select multiple subarrays.

4. To select subarrays and single cells, select the subarrays, toggle Select by Subarray off, then
select single cells.

The items within the selected subarray or subarrays are highlighted in blue in the well table view. The
plots display the results from the selected subarray or subarrays.

Review results in the Amplification Plot

If no data are displayed in the Quality Check tab, or if reanalysis is required, click Analyze.
For more information about the Ampilification Plot, see “Amplification Plot overview” on page 81.
Evaluate the overall shape of the curves in the amplification plot

1. In the Quality Check tab, in the plot pane, select Amplification Plot from the dropdown list.

2. Click £} (Settings), then make the following selections:

* Color By: Target, Sample, or Well
* Y Value: ARn
* Y Scale: Log
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3. (Optional) To show or hide the background grid in the amplification plot, click £ (Settings), then
select or deselect the Grid checkbox.
4. Review the overall shape of the curves in the amplification plot.

For more information about the amplification plot, see “Amplification Plot overview” on page 81.

Amplification Plot

© ®

L

1

0.100

®
AR

0.0100

©

5 10 15 20 25 30 35 40

Figure 1 Typical amplification plot
A typical amplification curve has four distinct sections:

@ Baseline @ Linear phase
@ Exponential (geometric) phase @ Plateau phase

Review the amplification status for each well

Note: Amp Status is only applicable for analysis that includes a PCR stage.

In the Quality Check tab, in the Well Table, review the amplification status of each well.
The Amp Status column displays one of four values:

Amplification status value Description
Amp Target amplified.
No Amp Target did not amplify.
Inconclusive Unable to determine if amplification occurred. Review run data.
N/A One of the following occurred.
* The well was omitted from analysis.
¢ |Insufficient cycle number to determine if amplification occurred.
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Review or edit threshold settings in the amplification plot

The default analysis setting is for automatic threshold. To set the threshold manually, see “View or edit
Cq settings” on page 48.

The threshold values can be edited only if the baseline threshold is selected as the algorithm (see “View
or edit Cq settings” on page 48).

1. In the Quality Check tab, in the plot pane, select Amplification Plot from the dropdown list.

2. Click £} (Settings), then make the following selections:

* Plot Color: Target, Sample, or Well
* Y Value: ARn
® Y Scale: Log

The amplification plot is displayed for all wells.

3. (Optional) To show or hide the background grid in the amplification plot, click £# (Settings), then
select or deselect the Grid checkbox.
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A

4. Review the threshold values to determine if editing is necessary. A threshold set above or below
the optimum can increase the standard deviation of the replicate groups.

Table 1 Examples of threshold settings

Threshold setting evaluation Example

Amplification Plot

1.00

0.100

ARn

Threshold set correctly. -
0.0100 =5\

0.00100 =}

Cycle

Ampilification Plot

Threshold set too low.

1.00

0.100

ARn

Threshold set too high.

5. (Optional) Adjust the threshold in the exponential phase of the amplification curve.

Note: For easier viewing, ensure that the Y Scale is set to log (default), not linear.

¢ Click-drag the threshold bar into the exponential phase of the curve.
* Edit the Cq analysis settings (see “View or edit Cq settings” on page 48).
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Review or edit baseline settings in the amplification plot
1. In the Quality Check tab, in the plot pane, select Amplification Plot from the dropdown list.

2. In the plot pane, click £ (Settings), then make the following selections:

¢ Y Value: Rn

® Y Scale: Linear
e Color By: Well
* Baseline

The baseline can be selected only if the baseline threshold is selected as the algorithm (see “View
or edit Cq settings” on page 48).

Note: The start and end cycles are used to calculate the baseline.

The amplification plot is displayed for the selected wells in the Plate Layout pane.
The start and end cycles display for each well.

3. (Optional) To show or hide the background grid in the amplification plot, click £¢ (Settings), then
select or deselect the Grid checkbox.

4. (Optional) Adjust the start and end cycle values for the baseline (see “View or edit Cq settings” on
page 48).

Amplification Plot

10.0 4

Rn

Cycle

Figure 2 Example of correct baseline

Set the end cycle a few cycles before the cycle number where significant fluorescence signal is detected.
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Review results in the Amplification Plot
Optimize display of negative controls in the amplification plot
1. In the Quality Check tab, in the plot pane, select Amplification Plot from the dropdown list.

2. In the plot pane, click £ (Settings), then make the following selections:

* Y Value: ARn

® Y Scale: Linear

¢ Color By: Target

* Deselect Show: Threshold

® Deselect Show: Baseline

3. (Optional) To show or hide the background grid in the amplification plot, click £¢ (Settings), then
select or deselect the Grid checkbox.

4. In either the Plate Layout or Well Table, select the negative control wells (wells that should not
have amplification for a particular target).

5. In the plot pane, click & (Settings), then make the following selections in the Y Axis tab.
a. Deselect Auto-adjust range.

b. Enter Minimum value of -1.

c. Enter Maximum value of 2.

Amplification Plot
2.00 —

1.50 —

1.00 —
C
o 0.500
<

0.00

-0.500

-1.00 T I | I T I I
5 10 15 20 25 30 35 40

Cycle

Figure 3 Example amplification plot of negative controls

The linear plot displays the amplification plot for negative controls as smooth lines. The expanded y-axis displays low
levels of amplification.
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Identify and omit outliers from analysis

Outlier wells have C values that differ significantly from the average for the associated replicate wells.
To ensure Cg, precision, consider omitting the outliers from analysis.

1. In the Quality Check tab, select Amplification Plot from the dropdown list.

2. In the plot pane, click & (Settings), then make the following selections to configure the plot:

* Y Value: ARn
® Y Scale: Linear
e Color By: Well

3. (Optional) To show or hide the background grid in the amplification plot, click £¢ (Settings), then
select or deselect the Grid checkbox.

4. To identify outliers in the Plate Layout, select Cq from the dropdown list.
The C, values for each well are color-coded according to the value.

5. Omit outliers in either the Well Table or Plate Layout.

* |n the Well Table, select Omit in the row of the outlier well.
* In the Plate Layout, select a well or multiple wells, then select --- (Actions) » Omit Wells.

6. Click Analyze to reanalyze the run data with any outliers removed.

Review results in the multicomponent plot

If no data are displayed in the Quality Check tab, or if reanalysis is required, click Analyze.

1. In the Quality Check tab, in the plot pane, select Multicomponent Plot from the dropdown list.

2. Click £} (Settings), then select Dye from the Color By dropdown list.
The Multicomponent Plot is displayed for all wells.

3. (Optional) To edit the dyes that are displayed in the plot, click Dyes, then select dyes from the
dropdown list.

4. (Optional) To show or hide the background grid in the multicomponent plot, click £# (Settings),
then select or deselect the Grid checkbox.
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Review results in the raw data plot

5. In the Plate Layout, select wells one at a time, then examine the Multicomponent Plot for the
following plot characteristics.

Plot characteristic Description

Passive reference dye The passive reference dye fluorescence signal should remain relatively constant
throughout the PCR process.

Reporter dye The reporter dye fluorescence signal should display a flat region corresponding to the
baseline, followed by a rapid rise in fluorescence as the amplification proceeds.

Irregularities in the signal | Spikes, dips, and/or sudden changes in the fluorescence signal may have an impact on
the data.

Negative control wells The negative control wells should show no significant increase in fluorescence signal.

Multicomponent Plot
1.4M

1.2M —
1.0M
0.8M —

0.6M —

Fluorescence

0.4M —

0.2M —

5 10 15 20 25 30 35 40
Reading
@ FAM @ ROX

Figure 4 Example multicomponent plot (single well)

Review results in the raw data plot
For more information about the raw data plot, see “Raw Data Plot overview” on page 82.
If no data are displayed in the Quality Check tab, or if reanalysis is required, click Analyze.

1. In the Quality Check tab, in the plot pane, select Raw Data Plot from the dropdown list.

2. (Optional) To show or hide the background grid in the raw data plot, click £* (Settings), then select
or deselect the Grid checkbox.

3. Click-drag the Cycle Number slider from cycle 1 to cycle 40, then confirm that each filter displays
the characteristic signal increase.

For more information on each filter set, see the instrument documentation.
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Review results in the melt curve plot

Amplitude

Raw Data Plot

0.0M :
N
+,\§‘ &,6‘
Filters
@—Cycle Number .
40 1 8 16 24 32 40

Figure 5 Example Raw Data Plot

@ Slider to select the cycle

Review results in the melt curve plot

46

For custom experiments with more than one melt curve stage. For more information about the melt
curve plot and the melt peak parity factor, see “Melt Curve Plot overview” on page 83.

For analysis with more than one melt curve stage, select the melt curve stage to analyze in the analysis
settings (see “View or edit melt analysis settings” on page 51).

—
.

N

In the Quality Check tab, in the plot pane, select Melt Curve Plot from the dropdown list.

In the plot pane, click £¢ (Settings), then make the following selections:

* Color By: Sample, Target, or Well

* Plot Type: Derivative

3. (Optional) To show or hide the background grid in the melt curve plot, click £¥ (Settings), then
select or deselect the Grid checkbox.

4. Review the plot for evidence of unexpected multiple peaks, which can indicate non-specific
amplification or formation of primer-dimers.

5. Review the Well Table for the calculated T, in each well.
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Melt Curve Plot (Derivative)

60 65 70 75 80 85 90

Temperature (°C)

Figure 6 Example Melt Curve Plot

Review QC alerts in the well table

If no data are displayed in the Quality Check tab, or if reanalysis is required, click Analyze.

1. In the Quality Check tab, review the Well Table for alerts in the following columns.

Curve Quality column
Result Quality Issues column

For more information about the QC alerts, see “Overview of the result quality checks” on page 78.

2. Adjust the QC alert settings as needed (see “View or edit QC alerts settings” on page 49), then
reanalyze.

Review results in the plate layout

1. In the Quality Check tab, in the Plate Layout pane, select one of the following from the Color By
dropdown list:

Sample

Target

Cq

Cq Confidence
Amp Score
Amp Status

2. Review the results for each well (see “Acceptance criteria for result quality checks” on page 79).
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Edit primary analysis settings

Primary analysis settings include:
* (4 settings
* Melt settings
* QC settings

We recommend that you analyze data with the default analysis settings. If the default analysis settings
are not appropriate for the data, modify the analysis settings, then reanalyze the data.

View or edit C,, settings

* The default Cq settings are appropriate for most applications. Edit the threshold and baseline
settings for analysis of atypical or unexpected run data.

* Forinformation about Cq analysis, see “About the quantification cycle (Cq)” on page 75.

* For information about C, settings, see “Cq settings overview” on page 76.

1. Open a plate file or data file, then click Actions » Primary Analysis Setting.
2. In the General tab, select an option from the PCR Stage/Step dropdown list.

3. Select an option from the Algorithm Settings dropdown list.

* Relative Threshold
e Baseline Threshold

4. (For relative threshold algorithm settings) Select the PCR stage and step from the PCR Stage/Step
dropdown list.

5. (For relative threshold algorithm settings) Enter a start cycle in the Default Cgr Start Cycle field.

6. (For baseline threshold algorithm settings) To select the default threshold and baselines settings for
a target, select the checkbox in the Use Default column.

48 QuantStudio™ Design and Analysis v2 User Guide



7.

9.

10.

Chapter 4 Review and analyze data  [E97ie
Edit primary analysis settings

(For baseline threshold algorithm settings) To edit the settings, make the edits in the appropriate
table row.

Option Action
Use Auto Select the checkbox in the Auto Threshold column.
Threshold

Manually set the Deselect the checkbox in the Auto Threshold column, then edit the value in the
Threshold Threshold column.

Use Auto Baseline | Select the checkbox in the Auto Baseline column.

* To specify the Baseline Start cycle, Click AUTO in the Baseline Start column,
then enter the cycle number. The software will automatically determine the
Baseline end cycle.

* To remove the specified Baseline Start cycle, click the cycle number, then
delete it. The Baseline Start will revert back to AUTO.

Manually set the Deselect the checkbox in the Auto Baseline column, then edit the values in the
Baseline Baseline Start field and the Baseline End field.

(Optional) In the Well Cq tab, make the edits in the appropriate table row to apply custom Cy
settings to a specific well.

Click Save.

(Optional) To reset to the default settings, click Reset to Default.

View or edit QC alerts settings

1.

2.

Open a plate file or data file, then click Actions » Primary Analysis Setting.

In the QC Alerts tab, review selections:

® Curve Quality—(default) inactive

* Results Quality —(default) active

For more information about curve quality and results quality, see “Quality checks” on page 78.
(Optional) Select the Curve Quality checkbox.

(Optional) Set up the acceptance criteria for the result quality checks.
a. Ensure that the Results Quality checkbox is selected.

b. Select Results Quality.
c. Click 4= (Add).

d. Select the Sample Type from the dropdown list, then select the Target from the dropdown
list.

If a rule is set up for a specific sample type, it takes precedence over a rule that is set for all
samples.
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e. In the right panel, select the acceptance criteria for each sample type and target combination
(see “Acceptance criteria for result quality checks” on page 79).
f. (Optional) Click X (Remove) to remove a sample type and target combination from the table.
5. Click Save.
6. (Optional) To reset to the default settings, click Reset to Default.

In the Quality Check tab, click Analyze, then review the QC alerts in the Well Table.

View or edit advanced settings
1. Open a plate file or data file, then click Actions » Primary Analysis Setting.

2. In the Advanced tab, select and/or enter the following, then click Save
* Use a variant of primary analysis algorithm via plugin
¢ Set the Delta-Rn below which curves will be considered Non-Amplified

For QuantStudio™ Design and Analysis v2.7 and later, any curves with the AR, below the threshold
are set to non-amplified. This is regardless of whether there is a C value.

For QuantStudio™ Design and Analysis v2.6 and earlier, if the AR, is below the threshold but there
is a Cq value, the curves are set to inconclusive

3. Select the Reduce dye signal crosstalk by algorithm.

Note: Selecting this option might slow down the analysis.

For a description of this setting, see “Overview of the algorithm reduce dye signal cross-talk” on
page 51.

4. Click Update to upload a custom configuration file for the algorithm to reduce dye signal crosstalk.

Note: A custom configuration file must be obtained from Thermo Fisher Scientific.

A default configuration file is included in the primary analysis plugin of the software.
A configuration file is in the CFG file format.

If a custom configuration file is uploaded, the name of the configuration file is displayed in the
dialog box.

5. If a custom configuration file was uploaded, click Reset to return to the default configuration file.
The custom configuration file is removed.

6. Click Save.

7. (Optional) To reset to the default settings, click Reset to Default.
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Overview of the algorithm reduce dye signal cross-talk

Dye signal cross-talk can be observed when the dye calibration does not exactly match the spectrum of
the assay. This appears as false dye signal that rises or drops under a true dye amplification.

An algorithm is available to reduce the dye signal cross-talk. The default setting is that it is not used. It
can be applied in the primary analysis settings, in the Advanced tab.

The use of the algorithm slows down the analysis.
The impact and effectiveness of this algorithm must be assessed for individual assays.
This algorithm cannot be used for the OpenArray™ Plate format.

The algorithm is not available if any of the following conditions apply:

* The algorithm in the primary analysis plugin is different than what was used for the primary analysis
of the data file.

* The configuration file was updated between the time of data analysis and the that the algorithm
would be applied.

If the algorithm was applied, the data must be reanalyzed when there are changes to the dyes in the
plate setup. The reanalysis applies to the wells that were edited.

If the algorithm was applied, the data must be reanalyzed if calibrations from another file are applied.

View or edit melt analysis settings

For descriptions of the melt analysis settings, see “Melt analysis settings overview” on page 77.

—

. Open a plate file or data file, then click Actions » Primary Analysis Setting.
2. In the Melt tab, select an option from the Melt Stage/Step dropdown list.

3. In the Multi-Peak Calling column, select the checkbox.

The threshold type, peak level, and peak height settings are available only when multi-peak calling
is enabled.

4. Inthe Threshold Type column, select one of the following options.

* Percentage
* Height

5. In the Peak Level (%) column, enter a value.
A value can be entered only if Percentage was selected in step 4.

6. Inthe Peak Height column, enter a value.
A value can be entered only if Height was selected in step 4.

7. (Optional) In the Melt Peak Parity Factor field, enter a factor for the applicable targets.

Note: If the melt peak parity factor is applied to wells without a reaction mix, this can lead to
unexpected T, results.
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A factor of 0 turns off the feature. Negative values are not permitted.

The melt peak parity factor does not affect the High Resolution Melt Analysis Module if this module
is enabled.

8. Click Save.

9. (Optional) To reset to the default settings, click Reset to Default.

Use the analysis settings from another file

Apply analysis settings from a plate file or data file to an open data file. If you are analyzing a legacy
data file (see “Compatible data files” on page 8), you can use this feature to apply updated analysis
settings to the legacy data file before analysis.

The following analysis settings are applied to the data file:
* Primary analysis settings
* Analysis module analysis settings

Applying analysis settings from another file is not available for the OpenArray™ Plate format.

Note: You can only apply analysis settings from another file if the analysis settings are compatible with

the new file. Confirm the following before applying analysis settings to the new file:

. The run method consists of the same stages in both files (PCR stage, Melt stage, Pre-Read stage
and Post-Read stage).

. The selected analysis module is the same in both files.

. The sample and target/SNP assay information is the same in both files. Because some analysis

settings are specific to samples and target/SNP assay setup, remove any sample and target/SNP
assay information that is not applicable to the new data file.

1. Open a data file, then click Actions » Use Settings from Another File.
2. Navigate to the plate file or data file that contains the desired analysis settings.

3. Select the file, then click Open.
The data is reanalyzed using the new analysis settings.

4. Click Actions » Save to save the new analysis settings to the data file.
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View instrument calibration results

Transfer calibration data files from the instrument. For more information about instrument calibration,
see the instrument documentation.

Calibration results from the OpenArray™ Plate format are not available.

In some cases, you can use calibration data from another instrument for analysis of your data file. For
more information, see “Use the calibrations from another file” on page 54.

1. In the home screen, click View Data.
2. In the Data Gallery, click Actions » Open File.

3. Navigate to the location that was selected when the calibration data files were transferred from the
instrument, then select the calibration data file.

1. The calibration data file is opened, and calibration results are displayed.
2. The calibration data file is added to the Data Gallery, and appears in the Recents tab.

Review ROI/Uniformity calibration results

1. In the ROI tab, select a Filter Set from the dropdown list to see the corresponding results.

2. In the Uniformity tab, review results in the plot, the Well Table, or the Plate Layout.

Review Background calibration results
1. Review the calibration properties, including calibration status, in the menu bar.
2. Select the plate wells in the Plate Layout or the Well Table to view the corresponding curves.

3. Review data in the Well Table.
a. Review the results for each well in tabular format.

b. Sort the wells according to well or normalized fluorescence with each filter.

c. Select wells to review data in the analysis plot.

Review Dye calibration results
1. Review the calibration properties, including calibration status, in the menu bar.
2. Select a Dye row in the Calibration table to view the corresponding analysis data plot.

3. Select the plate wells in the Plate Layout or the Well Table to view the corresponding curves in
the plot .

4. Review data in the Well Table.
a. Review the results for each well in tabular format.
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b. Sort the wells according to well or normalized fluorescence with each filter.

c. Select wells to review data in the analysis plot.

Use the calibrations from another file

The use of calibrations from another file is not available for the OpenArray™ Plate format.

The calibrations must be from a run on the same instrument type and the same block type. The
calibrations must contain all of the applicable types of calibration for the instrument and block type.

The original calibrations are retained in the data file. You can revert back to the original calibrations.
Only one additional set of calibrations can be retained in the data file, excluding the original calibrations.

If the calibrations are reverted back to the original ones, the different calibrations are not retained in the
data file.

1. Open a data file, then click Actions » Use Calibrations From Another File.
2. Navigate to the location of the calibration file.

3. Select the file, then click Open.
The data are reanalyzed with the new calibrations.

4. (Optional) Click Actions » Revert to Original Calibrations.
The data are reanalyzed with the original calibrations.

Perform additional analysis

Perform additional analysis using one of the following options:

Option Description

To perform additional analysis using QuantStudio™ Design and Analysis

v2, select an analysis module (see “Select an analysis module” on
QuantStudio™ Design and page 68).

Analysis v2 analysis module ) ) ) )
For more information about analysis modules, see “Overview of the

analysis modules” on page 67.

. To perform additional analysis using a different application on the Thermo
Application on the Thermo Fisher™ Connect Platform, click i (AppConnect). Select the appropriate
Fisher™ Connect Platform ’ = 1APP ) pprop

application for your analysis.
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Export results

For information about export settings, see Chapter 9, “Manage export settings”.

Export the Well Table

1. In the Quality Check tab, in the Well Table, click --- (Actions) » Export.

2. Name the file, navigate to the desired folder location, then click Save.

Export plate layout as an Excel™ spreadsheet

To save an image of the plate layout, see “Export plate layout image” on page 55.

1. In the Quality Check tab, in the plate layout pane, click --- (Actions) » Export Plate View.

2. Name the file, navigate to the desired folder location, select the values to include, then click Save.

Export plate layout image

To save as an Excel™ spreadsheet, see “Export plate layout as an Excel™ spreadsheet” on page 55.

1. In the Quality Check tab, in the plate layout pane, click --- (Actions) » Save Image.

2. Name the file, navigate to the desired folder location, then click Save.

Export images of plots

1. In the Quality Check tab, in the plot pane, select a plot from the dropdown list.
2. Click --- (Actions) » Save Image.

3. Name the file, navigate to the desired folder location, select the file format and size, then click
Save.
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Export data
Export analyzed data for further analysis.
Save the analyzed data file before exporting the results (see “Save a plate file or data file” on page 65).

1. In a data file, click Actions » Export.

2. Enter or select the following, then click Save.
* Export Name
* File Format
¢ Destination—Click browse to navigate to the location.

* Export Settings—Select an export setting from the dropdown list, or edit the export settings
(see “View or edit export settings” on page 69).

3. Click Export.

Export data in the RDML format

Export analyzed data in RDML (Real-Time PCR Data Markup Language) format for standard curve,
relative standard curve, and comparative C; analysis.

Save the analyzed data file before exporting the results (see “Save a plate file or data file” on page 65).

1. In a data file, click Actions » Export to RDML.

2. Name the file, navigate to the desired folder location, then click Save.

Generate a report

Generate a customizable results report.
1. In a data file, click Actions » Generate report.
2. (Optional) Edit the file name.

3. (Optional) To edit the file destination, click Browse, then navigate to the desired location.
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4. In the Report Content pane, select the content to include in the report:

Report Content

Description

Summary

Displays a summary of the experiment, including the following information:

Bar Code

File Name

Run Start Date and Time
Run End Date and Time

Run Duration

Operator

Instrument Name
Instrument Type

Block Type

Block Serial Number
Heated Cover Serial Number
PCR Stage/Step Number
Quantification Cycle Method
Comment

Software Name and Version
Plugin Name and Version

Analysis Date and Time

Well Table

Displays the following information from Well Table in the Quality Check tab:

Well

Sample

Target

Task

Cq

Cq Confidence
Ampilification Score
Amplification Status

Cq Threshold (not applicable if the relative threshold algorithm is selected to calculate the
Cq values)

Baseline Start and End (not applicable if the relative threshold algorithm is selected to
calculate the G, values)

Replicate Group
Results

Displays the following information from Replicate Table in the Quality Check tab:

Sample

Target

Number of Replicates
Cq Mean

Cq Standard Deviation
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(continued)

Report Content Description

Displays the sample name, sample color, target or targets, and target C, value or values for
each well.

The subarrays are displayed for the OpenArray™ Plate format. The sample name is displayed
on each subarray.

Plate Layout

Amplification Plot

i ificati (11
(dRn) Displays the Amplification Plot (dRn vs Cycle)

Amplification Plot

Rn) Displays the Amplification Plot (Rn vs Cycle)(!]

Displays the Melt Curve Plot (Derivative Reporter vs Temperature)[?!

Melt Curve Plot . . . . .
This option only displays if the Run Method includes a Melt Curve stage.

Displays the thermal cycling protocol used in the Run Method.

Run Method ]
(Not applicable for the OpenArray™ Plate format.)

Displays the primary analysis information.

This includes the PCR state and step, the qualification cycle method, the baseline information,
and the threshold information.

Primary Analysis The QC alerts and advanced settings are displayed. See the following sections:

Settings * “View or edit QC alerts settings” on page 49

* “Overview of the result quality checks” on page 78

* “View or edit advanced settings” on page 50

) Displays the plots and analysis results for the selected analysis modules.
Analysis Module . . . . . .
This option only displays if an analysis module is selected.

' For more information about the Amplification Plot, see “Amplification Plot overview” on page 81.
@l For more information about the Melt Curve Plot, see “Melt Curve Plot overview” on page 83.

5. Select the wells or the subarrays to include in the report.

* (Default) All Wells checkbox.

* Customize checkbox—Select one or more wells or subarrays in the plate layout. The wells or
subarrays are colored by sample.

Option Action
Select one well or subarray Click the well or subarray
Select multiple contiguous wells or subarrays Click-drag over the wells or subarrays
Select non-contiguous wells or subarrays PC: Ctrl-click each well or subarray
Mac: Cmd-click each well or subarray
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General procedures to analyze data
in the Quality Check tab

For detailed procedures, see Chapter 4, “Review and analyze data”.

View the post-run summary

1. Open the data file.

2. In the Run Summary tab, view a summary of the run, including the following information:
* Run Start and Run End
® Operator and Block Type
¢ Heated Cover S/N and Block Serial S/N
¢ Instrument Software and Instrument Name
* Run Events and Calibration

Configure the layout of the Quality Check tab

1. In the Quality Check tab, click Actions » Page Layout Setting.

2. Drag up to four options to the display on the right.
Each option will display in a pane in the Quality Check tab.

3. (Optional) Drag the panes to rearrange the display in the Quality Check tab.
4. Click Save.

5. (Optional) To reset to the default settings, click Reset to Default.

Filter results in the Quality Check tab

1. In the left pane of the Quality Check tab, select the following to filter the results.

* Sample Type
* QC Alerts

Filtering by QC alerts is available only if there is at least one QC alert in the results.
* Samples
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Review the OpenArray™ Plate images

* Targets
* Biogroups
* (OpenArray™ Plate only) View

2. (Optional) To clear the selections, click Clear all.

Review the OpenArray™ Plate images

1. In the View dropdown list, select Plate Image.
The image is displayed.
2. In the Image type dropdown list, select one of the following options:

* ROX Images
* Spotfind Images
¢ Quant Images

3. Click the file to view.
The file is highlighted in blue. The file name is also displayed at the bottom of the image.

4. Use the magnification tools at the top-right corner of the image to zoom in, to zoom out, and to
reset the magnification.

5. Click on a subarray to view a magnified image of the subarray.
The selected subarray is displayed below the image of the full OpenArray™ Plate.

6. Use the sliders to adjust the image brightness and contrast.

¢ Brightness slider
* Contrast slider

7. Click the Comments field to add a comment for an image.

Overview of OpenArray™ Plate images

60

OpenArray™ Plate images can be viewed in the software. The images can be used to troubleshoot
problems.

Three categories of images are available:
* ROX™images
* Spotfind images
* Quantification images

The ROX™ images should display uniform fluorescence throughout the OpenArray™ Plate. The following
patterns indicate an issue.
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Review the OpenArray™ Plate images

Table 2 ROX™ image patterns and possible causes

Pattern Possible cause

Fluorescence is not displayed in sections of The OpenArray™ AccuFill™ Instrument is misaligned.
the subarray where the OpenArray™ AccuFill™
Instrument turns when loading the OpenArray™
Plate.

Fluorescence is not displayed in large sections | The immersion fluid is injected too quickly or injected
of a subarray near the fill port. without purging the syringe. This causes the sample to be
knocked out of the through-holes near the fill port.

Fluorescence is not displayed in large sections | There is an insufficient volume of reagents in the sample
of a subarray at the end of the fill path. plate. The tips run out of reagents before they reach the
end of the fill path.

There are obscured areas at the edge of the The case lid was not aligned correctly in the plate press.
OpenArray™ Plate.

There are very bright spots in a well. These bright spots are caused by dust or other
contaminants.

The wells display a dark center. There is evaporation. This is caused by low humidity levels
and excessive time passing before the immersion fluid is
added to the OpenArray™ Plate.

The spotfind images can indicate whether there are leaks. The spotfind images should appear with a
uniform pattern. Dark spots indicate leaks. Leaks should be confirmed by reviewing the quantification
images.

Quantification images display the fluorescent signals. They can indicate the following issues.

Table 3 Quantification image patterns and possible causes

Pattern Possible cause
There are very bright spots in a well. These bright spots are caused by dust or other contaminants.
The wells display a dark center. There is evaporation. This is caused by low humidity levels

and excessive time passing before the immersion fluid is
added to the OpenArray™ Plate.

There is variability in the brightness of the | There are leaks.
signal within the well.

Workflow to review the OpenArray™ Plate images
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Review individual well results in the Well Table

Review the images

Check for loading issues
View the ROX™ image POST-READ CHANNEL 4.

Check for leaks or displaced samples
View the following spotfind images:

® Genotyping runs: S01_C001 TO0<..> P0001 M2 X3 El1 CP<.> spotfind, where<...>is
variable

* Gene expression runs: S00_C001_T01 P0001 M2 X3 El1 CP<..> spotfind, where <...>is
variable

Check for fluorescent abnormalities and confirm any issues detected in
the spotfind images
View the quantification images:

* Genotyping runs: STAGE3 CYCLE1 CHANNEL 1 and STAGE3 CYCLE1l CHANNEL 2

* Gene expression runs: STAGE2 CYCLE40 CHANNEL 1

Review individual well results in the Well Table

In the Quality Check tab, view results for individual wells in the Well Table.

* Click View to select the columns that are displayed.
¢ Click on any column header to sort the table by that value.

* Select a well from the table to highlight the well in the Plate Layout or plot.

Note: Well selections are retained when viewing different plots.

Review Replicate Group results

1. In the Quality Check tab, click Replicate Group.

2. Examine the Cq mean and standard deviation for each replicate group to assess the precision of
C, values.
q
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Configure general plot settings

Configure general plot settings

1. In the Quality Check tab, in the plot pane, click £ (Settings).

2. Edit the following settings in the General tab.

Plot Title
Color By

Y Value

Y Scale
Thickness
Max Curves
Show

3. Edit the following X Axis and Y Axis settings in their respective tabs.

Label
Auto-adjust range —If deselected, select a Minimum value and Maximum value.

4. Click outside of the dialog box to close.
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Manage plate files and data files

Overview of system templates and plate files

A plate file contains the information that is necessary to perform an instrument run. A system template
is a non-editable plate file that is included with the software. Opening a system template automatically
generates a new plate file that can be edited, then saved (see “Select a system template or existing
plate file to set up a new plate file” on page 11).

A plate file can contain the following information:

Information type

Properties

Instrument setup

Instrument type

¢ Block
¢ Run mode
Run Method * Thermal protocol
¢ Filter settings
Plate Setup ¢ Sample definitions and well-assignments

Target or SNP assay definitions and well-assignments

Reagent information

Note: Plate setup information is not included in a system template and must be
defined by the user.

Primary Analysis Settings

Cg settings
Melt settings
QC settings

Advanced settings

Plate Information

Plate barcode and user-defined description

64
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Chapter 7 Manage plate files and data files
Overview of data files

o7

A data file contains the information from the plate file that was used to perform the instrument run. A
data file can also contain the following information:

Information type

Properties

Run summary

Run Start and Run End

Operator and Block Type

Heated Cover S/N and Block Serial S/N
Instrument Software and Instrument Name

Run Events and Calibration

Analysis results

Data plots

Cq and G, confidence
Amplification score and status
Melting temperature

Flags

Analysis module results (if applicable)

Data analysis completed using an analysis module.!!

' For more information about analysis modules, see “Overview of the analysis modules” on page 67.

Save a plate file or data file

* To save a plate file for the first time, or to save a plate file or data file with a new name, click

Actions » Save As.

* To save the plate file or data file with the same name, click Actions » Save.

Restrict editing of a plate file or data file

IMPORTANT! If you enable restricted editing in a plate file or data file, then you cannot save the file
with unrestricted editing. We recommend that you save a backup version of the file before you restrict

editing.

1. In an open plate file or data file, click Actions » Restrict Editing.

2. In the Restrict Editing window, select the features for which you want to restrict editing.

¢ Edit analysis settings
¢ Edit target/assay

* Assign target/assay
¢ Edit run method

The run method is never editable in a data file.
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Add a plate file to My Plate Files

Note: A blue checkbox () indicates that the function cannot be edited.

3. Enter and confirm a password, then click Restrict.

Note: Record the password because lost passwords cannot be recovered.

A lock icon (@) appears next to the file name in the software menu bar to indicate that restricted
editing is enabled.

4. (Optional) To update editing restrictions for a file, enter your password, modify the selections, then
click Update.

5. (Optional) To remove editing restrictions from a file, enter your password, then click Remove.

Add a plate file to My Plate Files

Save a plate file before adding it to My Plate Files (see “Save a plate file or data file” on page 65).

In an open plate file, click Actions » Add to My Plates.
The plate file appears in the in the Plate Gallery, in the My Plate Files tab.

Search for a plate file or data file

Add a tag to your plate file or data file to enable searching by that tag (see “Edit plate file or data file
information” on page 34).

1. Open the Plate Gallery or the Data Gallery.

2. Click Q, then enter the tag or tags.
Plate files or data files with the tag are displayed.
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To see all of the analysis modules that are installed, click ¥ System » Plugins.

Overview of the analysis modules

Analysis modules are plugins that enable additional data analysis using QuantStudio™ Design and

Analysis v2.

To select an analysis module, see “Select an analysis module” on page 68.

The following analysis modules are available to use:

Analysis Module

Description

Primary analysis

Calculates dye signals, Cq values, and other primary results from the filter signals.

Standard Curve

Use to determine absolute target quantity in test samples.

Genotyping

Use to detect single nucleotide polymorphism (SNP) variants of a target nucleic
acid sequence.

Presence Absence

Use to determine the presence or absence of a target nucleic acid sequence in a
sample.

Relative Quantification

Use to determine the relative quantity of a target of interest in a test sample relativ
to a reference sample. The analysis module supports relative quantification using
either comparative CT (AACT) analysis or relative standard curve analysis.

0]

For detailed information about the analysis modules, see one of the following sources:

* Analysis Module User Guide—See Appendix B, “Documentation and support”.

* Analysis Module Help—With an analysis module selected, click @ Help, then select the Analysis

Module Help.

QuantStudio™ Design and Analysis v2 User Guide

67




P2 Chapter 8 Manage analysis modules

Select an analysis module

Select an analysis module

68

The analysis module selection can be selected in either the plate file or the data file.

The genotyping analysis module and the presence absence analysis module are the only ones that are
available for OpenArray™ Plate data files.

The genotyping analysis module is automatically applied to data files from OpenArray™ Plate
genotyping runs.

1. In a plate file or data file, click Actions » Analysis Modules.

2. In the Analysis Modules window, select the analysis module, then click OK.

File type Result

The Help for the selected analysis module is displayed in the Help menu (® Help »

Plate file <Analysis Module> Help Contents).

* The analysis module Help is displayed in the Help menu ((® Help » <Analysis Module>
Data file Help Contents).

® The analysis module tab opens.

3. Save the plate file or data file retain the analysis module selection.
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About export settings

Export settings designate the data to include in the exported results. The software includes several
non-editable export settings files in the Export Settings library (click £ System » Export Settings to
view).

To edit the default settings, you must create a new export settings file (see “View or edit export
settings” on page 69).

Export settings can be applied to data exported by the software or by an instrument.

View files in the Export Settings library

1.

In any screen, click £¢ System » Export Settings.

Note: If you have a data file open, you will be prompted to save, then close the file. To view or edit
export settings without closing the current data file, see “View or edit export settings” on page 69

Click an export settings file to view.

(Optional) In the open export settings file, create a new export settings file, or edit an existing
custom export settings file.

View or edit export settings

View or edit export settings while a data file is open. You can also view or edit export settings from the
Export Settings library (see “View files in the Export Settings library” on page 69).

1.

2.

Open a data file.
Click Actions » Export.

In the Export Plate dialog box, select an option from the Export Setting dropdown list, then click
Customize.

To edit the export settings for Quality Check data, select Primary from the Analysis Module
dropdown list.

In the View dropdown list, select Metadata.
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10.

11.

12.

13.

14.

15.

16.

70

In the Select Fields pane, select the checkbox associated with each item in order to display it in
the exported file.

In the Select Fields pane, click an item in order to edit the text that is displayed in the exported
file.

The updated name is displayed in the Metadata Fields pane.
In the View dropdown list, select Resuilt.

In the Include dropdown list, select the data to include in the export.
Each item is exported as a separate file.

View the data in each tab.
¢ Results tab
* Amplification Data tab
* Multicomponent tab
* Raw Data tab
* Replicate Group Result tab

In the Select Columns pane, select the checkbox associated with the column in the table.

In the Select Columns pane, click an item in order to edit the text that is displayed in the exported
file.

Click the Options dropdown list to select the options for the values that are displayed in the
exported plate.

a. Select or deselect the Round values by checkbox, then enter a number in the Decimal
places field.

b. Select or deselect the Use double quote checkbox.
c. Select or deselect the Use two digits in well position checkbox.

Click the Options dropdown list to select the information to include in the exported plate.
* Section header checkbox
* Empty wells checkbox

* Omitted wells checkbox

(Optional) Click Save As, enter a name in the Export Name field of the Save As dialog box, then
click OK.
The saved settings are available as a selection in the Export Setting dropdown list.

Click Export to continue exporting results, or click Close.
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How
Download an export settings file

Download an export settings file

An export settings file can be imported into the Export Settings library or into the QuantStudio™ 6 Pro
Real-Time PCR System or the QuantStudio™ 7 Pro Real-Time PCR System.

—

. In any screen, click £+ System » Export Settings.

2. Hover over the export settings file, then click --- (Actions) » Download.

w

Name the export settings file, navigate to the desired folder location, then click Save.

To import an export settings file into the software, see “Import an export settings file” on page 71.

To import an export settings file into the QuantStudio™ 6 Pro Real-Time PCR System or the
QuantStudio™ 7 Pro Real-Time PCR System, see the instrument user guide.

Import an export settings file

Import a previously downloaded export settings file (see “Download an export settings file” on page 71).
1. In any screen, click £¢ System » Export Settings.

2. Click Actions » Import Setting.

3. Navigate to the export settings file, then click Open.
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Overview of the preferences

Preferences for the following items can be updated.
* Importing an AIF
® (Custom dyes
* Plate file format
* Result export

* Report generation

Manage preferences for AIF import

This setting determines the preferred target name when importing an assay information file (AlF).
1. In any screen, click £+ System » Preferences.

2. In the AIF Import pane, select one of the following items.

* Gene Symbol & Assay ID radio button
* Gene Symbol radio button

* Assay Name radio button

* Assay ID radio button

3. Click Apply.

4. Click Reset to reset to the default settings.

Manage preferences for custom dyes

After a custom dye is added to the system, it is available in the Manage Dyes dialog box when a plate
file is set up.

1. In any screen, click £+ System » Preferences.

2. In the Custom Dyes pane, click 4 (Add).
A new row is added to the table that contains the list of custom dyes.
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Manage preferences for the plate file format

3. Edit the following fields in the new row.
¢ Enter a name in the Dye Name field.
* Select a color from the color picker.
* Select a type from the Type dropdown list.
¢ Enter a wavelength in the Wavelength field.

4. Click ® (Remove) to remove a dye.

5. Click Reset to reset the default settings.

Manage preferences for the plate file format

1. In any screen, click £+ System » Preferences.

2. In the Plate File Format pane, select the Create plate file (.edt) in legacy format for
QuantStudio™ 1/3/5/6 Flex/7 Flex/12K Flex checkbox.

3. Click Apply.

4. Click Reset to reset the default settings.

Manage preferences for the results export

1. In any screen, click £¢ System » Preferences.

2. In the Result Export pane, select one of the following options.

* File name with date and time stamp radio button
* File name only radio button

3. Click Apply.

4. Click Reset to reset the default settings.

Manage preferences for the report generation

1. In any screen, click £+ System » Preferences.
2. In the Report Generation pane, enter a title in the Title field.

3. Select a paper size from the Paper Size dropdown list.

e A4
o Letter
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Manage preferences for the report generation

4. Select an option for the logo.

¢ Use the default report logo radio button
* Use a customized report logo radio button

5. (For customized report logo) Click Upload file here, then navigate to the location of the file.

The file can be in a JPEG file format or a PNG file format. The file size must be less than 500 KB.
The dimension are 1021 px x 218 px.

6. Click Preview to preview the report, then click Close.
7. Click Apply.

8. Click Reset to reset the default settings.
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About the quantification cycle (C)

The quantification cycle (C) is used for gene expression metrics quantification analysis. Algorithm-
specific calculations of Cq values are used as the primary input values for quantification analysis.

Algorithm Description

Cq (Cy) is calculated using the PCR cycle number at which the fluorescence signal meets the

Baseline Threshold threshold in the amplification plot.

Cq (Cy) is calculated using the PCR cycle number for the threshold calculated from the

Relative Threshold modeled amplification efficiency profile.

For more information about C, analysis settings, see “Cq settings overview” on page 76.

About melt curve analysis

Use melt curve analysis to determine the melting temperature (T,,) of the amplification products of a
PCR that used intercalating dyes.

Melting temperature (T,y,) is the temperature at which 50% of the DNA is double-stranded and 50%
is dissociated into single-stranded DNA. The melt curve of a single amplification product displays a
single peak at the T, of the product. Multiple peaks in a melt curve experiment indicate additional
amplification products, usually from non-specific amplification or formation of primer-dimers.

Multi-peak calling can be used when more than one product is expected in a reaction.
Melt curve analysis is included in the primary software analysis.

1. The software plots a melt curve based on the fluorescence of the dye with respect to change in
temperature.

2. Using the melt curve, the software calculates the melting temperature (T,,).

A melt peak parity factor is available. It normalizes the scaling of the melt curve peaks in multiplex
assays when the dyes fluoresce at different amplitudes. It helps to make the peak heights more
comparable across multiple dyes and targets.
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Primary analysis settings overview

C, settings overview

The default Cq settings are appropriate for most applications. Edit the settings for analysis of not typical
or unexpected run data.

Note: The run data must include a PCR stage to perform Cq analysis.

Table 4 C, settings

Setting Description

PCR Stage/Step If there is more than one PCR stage/step with data collection, the user selects PCR
stage/step from the dropdown list for C or G, analysis.

Baseline threshold analysis

Algorithm Settings — | The Baseline Threshold Algorithm is used to calculate the Cq values.

Baseline Threshold This algorithm is an expression estimation algorithm that subtracts a baseline component

and sets a fluorescence threshold in the exponential region.

Default C Settings | Determines how the Baseline Threshold Algorithm is set. The default settings are used for
targets and wells unless custom values are selected in the General or Well C, tabs.

For recommendations on adjusting baseline and threshold settings, see “Guidelines for
manual threshold and baseline settings for Cq analysis” on page 77.

Cq Settings for * Default Settings selected—The default C, settings are used to calculate the C, values
Target for the target.

¢ Default Settings deselected —The software allows manual setting of the baseline or the
threshold.

For recommendations for adjusting baseline and threshold settings, see “Guidelines for
manual threshold and baseline settings for Cq analysis” on page 77.

Relative threshold analysis

Algorithm Settings — | The Relative Threshold Algorithm is used to calculate the C, values.

Relative Threshold This algorithm is a well-based expression estimation algorithm that sets a threshold for

each curve individually. The threshold is based on the shape of the amplification curve,
regardless of the height or variability of the curve in its early baseline fluorescence.

Default C, Settings | Determines the default start cycle. The default start cycle is used for targets unless a
custom start cycle is indicated in the Well C tab.
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Guidelines for manual threshold and baseline settings for C, analysis

Setting Recommendation

Threshold | Enter a value for the threshold so that the threshold is:
* Above the background.
* Below the plateau and linear phases of the amplification curve.

* Within the exponential phase of the amplification curve.

Baseline | While in the linear plot view, select the Start Cycle and End Cycle values so that the baseline
ends before significant fluorescence signal is detected.

Melt analysis settings overview

* The Melt Peak Parity Factor field allows the entry of a factor.

This feature is for multiplex melt curve experiments. It normalizes the scaling of the melt curve
peaks in multiplex assays when the dyes fluoresce at different amplitudes. It helps to make the
peak heights more comparable across multiple dyes and targets.

A factor of 0 turns off the feature. Negative values are not permitted.

If the melt peak parity factor is applied to empty wells of a plate, unexpected T, values can occur.
The melt peak parity factor does not affect the High Resolution Melt Analysis Module if this module
is enabled.

* Enable or disable Multi-Peak Calling the Melt tab.

Multi-Peak Calling Description

Enabled — More than one PCR product is expected to amplify.
— T, will be determined for more than one peak.

Disabled — Asingle PCR product is expected to amplify.

- T, will be determined for one peak.

* (For multi-peak calling only, using the percentage as the threshold) Set the value in the Threshold
Type column to Percentage, then adjust the value in the Peak Level (%) column.

Specify a fractional-level value as the additional peak detection threshold. The detected peaks are
measured relative to the height of the tallest peak, which has a perfect fractional level of 100%. The
default value is 10%.

For example, if the peak level value is set to 40%, then peaks above 40% of the tallest peak are
reported, and peaks below 40% are regarded as noise.

* (For multi-peak calling only, using the height as the threshold) Set the value in the Threshold Type
column to Height, then adjust the value in the Peak Height column.
Specify a value as the peak detection threshold.

The absolute value of the peak is required to be above the value that is set in the Peak Height
column

To edit the melt analysis settings, see “View or edit melt analysis settings” on page 51.
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Figure 7 Melt curve before a melt peak parity factor is applied
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Figure 8 Melt curve after a melt peak parity factor is applied

Quality checks

There are two types of quality checks:
* Result quality check
¢ Curve quality check

Overview of the result quality checks
The result quality checks are used to describe the quality of the primary analysis results.

The following items can be displayed in the Result Quality Issues column of the Well Table:
* Amp Score out of range
* Unexpected Amp Status
* (Cq Value out of range
* (Cq Confidence out of range
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* (Cq Standard Deviation out of range

* Unexpected Cq Status

* Delta Rn out of range

¢ Multiple melt peaks

* Replicate group outlier

* Tm1 out of range

* Pass Ref Change out of range

Note: There can be multiple Result Quality Issues for a single well.

Acceptance criteria for result quality checks

Acceptance criteria

Description

Cq should be

¢ Expressed
¢ Undetermined

Any well outside of the user-selection will be flagged.

Cq Value Range

The C, Value is the primary input value for quantification analysis.

Any well outside of the user-defined minimum and maximum range will be
flagged.

Cq Confidence Range

The C, Confidence is a value that reflects the reliability of the derived C,.

Any well outside of the user-defined minimum and maximum range will be
flagged.

Cq Standard Deviation

The C, Standard Deviation is the standard deviation of the Cq of the replicates.

Range Any well outside of the user-defined minimum and maximum range will be
flagged.
Amp Status * Amp
* No Amp

* |nconclusive

Any well outside of the user-selection will be flagged.

Amp Score Range

The Amp Score is a value that indicates the quality of the amplification curve.

Any well outside of the user-defined minimum and maximum range will be
flagged.

Delta Rn Range

The Delta Rn is the calculated deviation from the baseline.

Any well outside of the user-defined minimum and maximum range will be
flagged.

Passive Ref Change (%)

Any wells with a change in passive reference greater than the threshold are
flagged.

Outlier in Replicate
Group

Any wells that have G, values that differ significantly from the average for the
associated replicate wells will be flagged.
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(continued)
Acceptance criteria Description
Tm Range Tm is the melting temperature calculated in °C.
Any well outside of the user-defined minimum and maximum range will be
flagged.
Multiple Melt Peak Any wells that have multiple peaks will be flagged.
Detection

Overview of the curve quality checks

The curve quality checks are used to describe the quality of the curve, including passive reference
signals and smoothness of the curve.

The following items can be displayed in the Curve Quality column of the Well Table:
* PRFDROP
* PRFLOW
* NOISE
¢ NOSIGNAL
¢ OFFSCALE
* SPIKE

Description of the curve quality flags

Flag Description

PRFDROP * Reported for only the PCR data.
* The passive reference signal changes near the C;.

PRFLOW * Reported for only the PCR data.

* The passive reference signal is low.

NOISE * Reported for only the PCR data.
¢ The noise for a curve is higher than other curves on the plate.

NOSIGNAL * Reported for the whole run.

* There is no signal in the well.

OFFSCALE * Reported for the whole run.

* The fluorescent signal is off the scale.

SPIKE * Reported for only the PCR data.
* There are noise spikes on the curve.
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Plots overview

Amplification Plot overview

The Ampilification Plot displays amplitude of fluorescence by well across a user-defined number of
cycles (default 40 cycles). You can use the amplification plot to perform the following tasks:

* Confirm or correct baseline and threshold values.
* |dentify outliers.

* |dentify and examine abnormal amplification. Abnormal amplification can exhibit one of the
following characteristics:

— Increased fluorescence in negative control wells

— Absence of detectable fluorescence at an expected cycle

Note: If you notice abnormal amplification or a complete absence of fluorescence, see the
instrument user guide for troubleshooting information.

— lIrregularities due to inefficient reactions or sample contaminants

Three plots are available. Some plots can be viewed as a linear or logqg graph.

Table 5 Amplification Plot types

Plot type Description Use to
ARn vs Cycle | ARn is the magnitude of normalized fluorescence * Identify and examine irregular
signal, relative to the baseline fluorescence, amplification.
generated by the reporter at each cycle during the e View threshold values for the run.

PCR ampilification.

Rn vs Cycle |Rn is the fluorescence signal from the reporter * Identify and examine irregular
dye normalized to the fluorescence signal from the amplification.
passive reference. * View baseline values for the run.
C; vs Well C is the PCR cycle number at which the * Locate outlying amplification
fluorescence meets the threshold in the amplification (outliers).
plot.
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Raw Data Plot overview

The Raw Data Plot displays the raw fluorescence signal for each optical filter during each cycle of the
real-time PCR read from the real-time PCR instrument.

Raw data are also collected for plate endpoint reads (genotyping and presence absence runs) and for
melt curves. Raw data can be collected at any point of the thermal cycling protocol. Raw data are not
specific to PCR reads.

Raw data collection is indicated by the camera icon in the run method (see “Run method elements” on
page 13).

Raw data have had background and uniformity calibrations applied. They are the data that are used
to produce the multicomponent data. Multicomponent data have dye calibrations and the algorithm to
reduce dye signal crosstalk processing implemented.

View the Raw Data Plot to perform the following actions:

* Confirm a stable increase in signal (no abrupt changes or dips) from the appropriate filter.
¢ Confirm that the correct reporter dyes were selected during plate file setup.

Multicomponent Plot overview

82

The Multicomponent Plot displays the complete spectral contribution of each dye over the duration of
the thermal cycling protocol.

Multicomponent data are produced whenever raw data are read from the instrument.
Use the Multicomponent Plot to obtain the following information.
* Confirm that the signal from the passive reference dye remains unchanged throughout the run.

* Review reporter dye signal for spikes, dips, and/or sudden changes.
¢ Confirm that no amplification occurs in the negative control wells.
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Plots overview

Melt Curve Plot overview

The Melt Curve Plot displays the melt curve of the amplification products in the selected wells.

Review the Melt Curve Plot to confirm that the amplification products in a well display a single melting
temperature (T,,). Multiple peaks in a melt curve indicate non-specific amplification or primer-dimer

formation.

Multi-peak calling is available when more than one peak is expected in a reaction. This is when more
than one PCR product is expected to amplify.

Table 6 Melt Curve plots

Plot

Description

Derivative Reporter
vs. Temperature

Displays the derivative reporter signal in the y-axis as a function of temperature.

The peaks in the plot indicate significant decrease in the intercalating dye signal, and
therefore the T,, of the amplified products. Use this plot to confirm a single T, of the
amplification products.

Normalized Reporter
vs. Temperature

Displays the fluorescence signal from the reporter dye normalized to the
fluorescence signal of the passive reference, as a function of temperature.

You can use this plot to check the quality of the fluorescence data.
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Troubleshooting

Observation

Possible cause

Recommended action

High fluorescence signal

The reaction volume is not
correct.

Ensure that reaction volumes in the plate are
correct and match the volume that is entered
in the Run Method tab.

Signals that exceed the

limit of normal fluorescence
can indicate fluorescent
contaminants on the plate or
on the sample block.

Examine the bottom of the reaction plate. If
there is contamination, prepare and run new
plate.

Identify the location of contamination
on the plate or sample block. For
detailed instructions, see the instrument
documentation.

Inconsistent communication
between instrument and
computer or instrument and
Connect

The instrument is configured
for both wired and wireless
network connection.

Ensure only one connectivity option is plugged
into the instrument (either an Ethernet cable or
a wireless adapter, but not both).

Configure for wired or wireless network
connection.

Weak or unstable internet
connection, especially if
configured for wireless.

Change the configuration to a wired
connection.

Use a wireless network with a stronger or
more consistent signal.
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Documentation and support

Related documentation

Document Publication number

QuantStudio™ Design and Analysis Software v2 Standard Curve Analysis Module User MANO0018746

Guide

QuantStudio™ Design and Analysis Software v2 Relative Quantification Analysis MANO0018747
Module User Guide

QuantStudio™ Design and Analysis Software v2 Presence Absence Analysis Module MANO0018748
User Guide

QuantStudio™ Design and Analysis Software v2 Genotyping Analysis Module User MANO0018749
Guide

QuantStudio™ 6 Pro Real-Time PCR System and QuantStudio™ 7 Pro Real-Time PCR MANO0O018045
System User Guide

QuantStudio™ 3 and 5 Real-Time PCR Systems Installation, Use, and Maintenance MANOO010407
Guide

QuantStudio™ 1 Real-Time PCR System Installation, Use, and Maintenance Guide MANO017853

QuantStudio™ 1 Plus Real-Time PCR System Installation, Use, and Maintenance Guide MANO0024786

Customer and technical support

Visit thermofisher.com/support for the latest service and support information.
* Worldwide contact telephone numbers

* Product support information
- Product FAQs

— Software, patches, and updates
— Training for many applications and instruments

® Order and web support
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Appendix B Documentation and support
Limited product warranty

* Product documentation
— User guides, manuals, and protocols

— Certificates of Analysis
— Safety Data Sheets (SDSs; also known as MSDSs)

Note: For SDSs for reagents and chemicals from other manufacturers, contact the
manufacturer.

Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth in the

Life Technologies' General Terms and Conditions of Sale at www.thermofisher.com/us/en/home/
global/terms-and-conditions.html. If you have any questions, please contact Life Technologies at
www.thermofisher.com/support.
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